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Getting started

The BlackBerry AtHoc management system uses the IIM add-on module interface with Giant Voice (GV)
outdoor warning devices to enable wide-area Mass Notification System (MNS) broadcasts. Giant Voice features
can broadcast critical information using voice messages, wave files, musical tones, or text-to-speech (TTS)
conversion. Public Address (PA) systems have large amplified speakers. Typically, speakers are set on poles in
an array that covers a specified area with enough acoustic sound to override the ambient noise with emergency
notification.

After the BlackBerry AtHoc management system is integrated with a Public Address (PA) system, operators
can disseminate emergency alerts to the siren system from the BlackBerry AtHoc management console. Alert
messages can be delivered using text-to-speech or pre-recorded audio files to up to three pre-defined target
zones by using the external call key inputs. A fourth external call key input is reserved for sending a "Cancel"
command to all poles.

| Getting started | 4



Configure the Public Address System delivery gateway

Configure the Public Address System gateway in the Settings section of the BlackBerry AtHoc management
system to enable the BlackBerry AtHoc alerts system to publish alerts through the Public Address System.

Enable the Public Address System gateway on the BlackBerry AtHoc
application server

Log in to the BlackBerry AtHoc management system and check the Delivery Gateways section to verify that the
Public Address System and XML Feed device gateways have been installed. If they are installed, skip this section.

1. Log in to the BlackBerry AtHoc application server as an administrator.

2. Navigate to the following folder <I WBAl erts | nstal | Pat h>\ Server Obj ect s\ Tool s and run
the At Hoc. Appl i cati ons. Tool s. | nst al | Package. exe file.

On the Configure Device Support screen, select Public Address System and Xml Feed.

Click Enable.

On the Installation Complete window, click OK.

Click Close.

o sw

Configure the delivery gateway

1. Log in to the BlackBerry AtHoc management system as an administrator.
2. |n the navigation bar, click &3,

3. In the Devices section, click Public Address System.

4. On the Public Address System page, click Copy default settings.

5. Click Save.

6. In the navigation bar, click 3]

7. In the Devices section, click Xml Feed.

8. On the Xml Feed page, click Copy default settings.

9. In the Feed Source section, select Delivery Gateway ID.

10.Click Save.

Configure the Public Address System device

Log in to the BlackBerry AtHoc management system as an administrator.

In the navigation bar, click )

In the Devices section, click Devices.

On the Device Manager page, click Public Address System.

On the Public Address System page, click Edit.

In the Delivery Gateway section, from the Add a Delivery Gateway list, select Public Address System.

Click Configure to open the text-entry field for the Public Address system gateway.

By default, the configuration value appears in the text-entry field. If the text-entry field is empty, complete the
following steps:

NGO sE®WDN=2

a. Click Remove.
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b.
c.
d.

Select Public Address system.
Click Configure.
Copy the following text into the field:

<Confi gurati on>

<CapPar ans>
<GVSyst enfType>PA</ GVSyst enTType>
<Al | Mode>0</ Al | Mbde>
<ZoneMode>0</ ZoneMbde>
<KeyMode>4</ KeyMode>
<UnusedMbde>0</ UnusedMode>
<Defaul t Al | Cal | >0</ Defaul t Al'l Cal | >

<Def aul t KeyAct i vat i onCode>0</ Def aul t KeyAct i vati onCode>

<NoPARequi r ed>0</ NoPARequi r ed>
<PARequi r ed>1</ PARequi r ed>
<PAWAV>1</ PAVAV>

<l sCancel abl e>f al se</| sCancel abl e>

<Cont ent Sour ce>G ant Voi ce</ Cont ent Sour ce>

</ CapPar ans>
</ Confi guration>

9. Click Save.
10.Click Enable.

Configure the XML Feed device

NGO RE®WDN=

Log in to the BlackBerry AtHoc management system as an administrator.

In the navigation bar, click 3]

In the Devices section, click Devices.

On the Device Manager page, click Xml Feed.
On the Xml Feed page, click Edit.

In the Delivery Gateways section, click Add a Delivery Gateway and select Xml Feed.

Click Configure to open the text-entry field for XML Feed gateway.

By default, the configuration value appears in the text-entry field. If the text-entry field is empty, complete the
following steps:

a.
b. Select XML Feed.

c.

d. Copy and paste the following text into the field:

Click Remove.

Click Configure.

<Conf i gurati on>
<Devi ceType>FEED</ Devi ceType>
</ Confi guration>

Click Save.

| Configure the Public Address System delivery gateway | 6



Set up mass device endpoints (targets)

To create a speaker pole, zone, or a poles endpoint (target), an operator should perform the normal Mass Device
Endpoint creation flow. You should give the endpoint a functionally descriptive name, so that it is recognizable in
Notification Templates and Report windows as a mass-communication device target entity.

Create mass device endpoints

1. Log in to BlackBerry AtHoc management system as an administrator.

2. |n the navigation bar, click &,

3. Inthe Devices section, click Mass Device Endpoints.

4. On the Mass Device Endpoints screen, click New > Public Address System.

5. On the New Mass Device Endpoint screen, in the General section, enter a name in the Endpoint Name field.

6. In the Configuration section, in the Address field, enter call key N,0. Ensure that there are no spaces anywhere
in the character string.

7. Click Save.

Create and publish a Public Address System alert template

Prerequisites

+ Before you start sending test alerts through Public Address System, consider the impact it has on everyone
within hearing distance of the poles you are using during the test.

+ This process assumes that the IIM is not configured to download data from the BlackBerry AtHoc
management server and is not connected to the Giant Voice equipment.

+ Consult with your POC about the acceptable content of the test alert. For example, the word "test” should
appear at, or very near to, the start of the broadcast message.

« Although the initial use of this template is to test the data creation process, this template can be used during
the audio tuning phase after the IIM and Giant Voice hardware are connected.

To confirm that the Public Address System device is installed correctly on the BlackBerry AtHoc management
system, create a template.

Log in to the BlackBerry AtHoc management system as an administrator.

Click Alerts > Alert Templates.

Click New.

On the New Template screen, in the Alert Template section, enter a template name and description.
Select a folder from the Folder list.

Select Available for quick publish and Available for mobile publishing.

In the Content section, enter the title and content of the alert.

In the Mass Devices section, select Public Address System and then from the list select one or more Mass
Alert Endpoints.

9. In the Mass Device section, click Options.

10.0n the Mass Devices Options screen, select Text to Speech and Alert Body or Custom Text.
11.Click Apply.

12.In the Schedule section, change the Alert Duration to 15 minutes.

13.Click Save.

14.click &.

15.0n the Home page, in the Quick Publish section, find the alert template you just created.

ONoa AN~
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16.Click Review and Publish.
17.Click Publish.

Verify the published alert
Verify that the alert was published successfully to the syndication feed.

1. Open a browser and navigate to the following URL: ht t ps: // <ur | >/ syndi cat i on/ gat ewayi d/
<or gani zati on-i d>/ capi ndex.

Where <url> is the base URL of the BlackBerry AtHoc management system (for example, https://
integration7.athoc.com) and <organization-id> is the 7 or 8-digit organization ID.

2. Copy the content in the <url> field into another browser. The “caplndex” XML format must be similar to the
content in the following image:

<?xml version="1.0"?>
- <caplIndex xmins="http://www.incident.com/cap_index/1.0">
<title>Current CAP Messages</title>
<updated>2018-08-29T01:26:47.2516109-07:00</updated>
- <item xmlins="http://www.incident.com/cap_index/1.0">
<id>293C2867-64E2-4B0OD-BBD5-FEC10C74CFOC</id>
<identifier>293C2867-64E2-4B0OD-BBD5-FEC10C74CF0OC</identifier>
<sender>AtHoc Admin</sender>
<status>System</status>
<msgType>Alert</msgType>
<firstEffective>2018-08-29T01:26:02.913 < /firstEffective>
<lastExpires>2018-08-29T01:41:02.913 </lastExpires>
<url>https:/ /integration7.athoc.com/Syndication/CAP_PA_2050363/Caplim/1147460</url>
<bounds/>
<format>http://www.incident.com/cap/1.1</format>
</item>
</capIndex>

3. Verify the <addresses> and <code> and match with the following format. The “alert” XML format must be
similar to the content in the following image:
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<?xml version="1.0"?>
- <alert xmlIns="urn:oasis:names:tc:emergency:cap:1.1">
<identifier>CAP_PA|581336|293C2867-64E2-4BOD-BBD5-FEC10C74CF0C|1147460|PUBLISH </identifier>
<sender>BlackBerry AtHoc Alerts</sender=>
<sent>2018-08-29T01:26:02-07:00</sent>
<status>Actual</status>
<msgType>Alert</msgType>
<source>System Default</source>
<scope>Public</scope>
<addresses>PA,0,0</addresses>
<code>0,1</code>
- <info>
<category>Other</category>
<event/>
<urgency>Unknown</urgency>
<severity>Unknown < /severity >
<certainty >Unknown </certainty >
- <eventCode>
<valueName>ATHOC</valueName>
<value>IWSA</value>
</eventCode>
<effective>2018-08-29T01:26:02-07:00</effective>
<expires>2018-08-29T01:41:02-07:00</expires>
<senderName>MassDev</senderName>
<headline>this is test only, TTS test please ignore.</headline>
<description=>this is test only, TTS test please ignore. Please ignore, no action required.</description>
<instruction/>
<contact>support@athoc.com</contact>
- <parameter>
<valueName>AUDIO-REPEAT-MODE</valueName>
<value>2</value>
</parameter>
- <parameter>
<valueName>AUDIO-REPEAT</valueName>
<value>1</value>
</parameter>
</info>
</alert>

4. If any of the formatting does not match, review the Public Address System gateway XML content and mass
communication users' Public Address System device addressing.
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Configure IIM IP connectivity

This section describes how to configure the IP Integration Module (1IM) to communicate with the BlackBerry
AtHoc Public Address System device.

Prerequisite
Ensure that the following packages are installed and configured before performing any tasks:

Latest Public Address System BlackBerry AtHoc device package
Latest Public Address System I[IM Capnode package
Latest IIM Agent

To work as part of the BlackBerry AtHoc system, IIM must be able to communicate with the BlackBerry AtHoc
server to download CAP packets.

The initial configuration data you need to collect are:

The BlackBerry AtHoc Alerts system base URL
The BlackBerry AtHoc Alerts Organization ID
Customer’s proxy server and port information

To find this information, use a local PC to log in to your local instance of the BlackBerry AtHoc management
console. The URL can be a base “https” address used to access a specific system. You can obtain the URL of

the system from the local system administrator or from the Blackberry Customer support team. Launch the
management console. The URL from the “https” to the last character before the third forward slash (/) is the “base
URL" of the system. For example, in the following URL address bar, the full URL for the sign-on page is: “https://
integration7.athoc.com/client/auth/login?ReturnUrl=%2fclient%2fathoc-iws". The “base-URL" of the system is
“https://integration7.athoc.com".

The organization ID is a 7 or 8-digit numerical identifier of the specific system of that customer. To obtain this
Organization ID, log in to the BlackBerry AtHoc management system for the customer. Once logged in, you can
find the system’s organization ID at the top right of the Home Page of the system.

Navigate to the settings page of the browser and determine if you are using any type of Proxy server for routing

of internet traffic. For example, if the browser you are using is Microsoft Internet Explorer (IE), go to the LAN
settings, in IE, select Tools > Internet Options. On the Internet Options screen, click Connections. At the bottom of
the window, click LAN settings.

In the Proxy Server section, click Advanced. The Proxy Settings screen displays the Proxy Server Address.
Record the proxy server address and the port number. You can now close these settings windows and exit IE.

Note: If your IE instance does not use proxy servers, when you click LAN settings, no proxy server is used for
internet traffic on this network.

Configure the system_private.config file

1. Open Microsoft Notepad as an administrator.

2. Click File > Open.

3. Navigate to C: \ Progr am Fi | es\ capnode and change the file selection from Text Documents (*.txt) to All
Files (*.%).

4. Selectthe system private. confi g file.

. Click Open.

6. Verify the following items in the syst em pri vat e. confi g file:

a
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a. Thei ndexURL variable should be formatted similar to the following image. The base URL should be
followed by “/syndication/”, then the device gateway protocol ID (for example, CAP_PA), the organization ID
number, followed by "/capindex”.

b. The “#” at the beginning of a line in the syst em pri vat e. conf i g file is used to comment out an unused
line. The “#" should be removed from a line to use the variable.

7. Enter the proxy server and proxy port information you collected earlier in the proxyServer and proxyPort
parameters.

If the settings on the machine that you tested with is set for “Automatic” in the proxy settings, the settings for
those two lines displays as follows:

* proxyServer=none
+ proxyPort=8080
8. Update the CapPostingTarget variables to reflect the correct URL using the same base URL as in
the i ndexURL variable.
=10] X

Fle Edt Format View Meb

‘-prna(e System Properties For Capcon
‘-cor‘figured 20150918 AtHoC

‘-Site Specific

lencoders=com. ha. capnode.drivers.sirencentral. Sirencentralencoder

]\rdexLRL-P‘ups 1//integrations., athoc, com,/ Syndication, CAP_aHELEN_VZ 2080320, capindexT ast«00c00F 26650F
ProxXyServer=none

lproxyPor t=8080

deTayBetweenRxPoT 3=

s
“ercccer .SirenCentraléncoder. TTS_Synthesizer Index=0
‘ercccer. Sirencentralencoder. TTS_voiceIndex=l
[encoder. Sirencentralencoder. TTS_volumes9l

‘ercccer .SirenCentralencoder. TTS_Speed«65

jencoder. SirenCentralencoder.TTS_Pitche120

(crcccor. Sirencentralencoder. TTS_Range=15

|
|

wrelay

encoder.SirenCentralencoder.SirenCentraloriverwhelen. shortdelay=500

encoder. Sirencentralincoder. Sirencentraloriverahelen. Delay_for_PAcode_TxX=5000
lencoder. Sirencentralencoder.relaysl; 3;4

encoder. Sirencentralencoder.ptt_before=100;100; 1000

encoder. SirenCentralencoder.ptt_after«100;100; 1000

j#PosTCap

)Cappostingrarget=True

APPOITINGTAr QEL. CAPUr [=NtLp3 . TNLegr ATI0NT ., AThoc. com Syndication PoOStCap
[CapPostingTarget. user=

[CapPostingTarget. passwords

9. Click File > Save. Close the syst em pri vat e. confi g file.
10.Restart the CapCon service.

Restart the CapCon service

1. Navigate to your IIM system.
2. Go to Start > Run > Services.

3. Launch an instance of the Services Manager application. There should be a quick-launch icon in the taskbar of
the desktop.

4. Scroll down to the IIM CapCon Service.
5. Right-click on the CapCon Services row and select either restart or stop and then start the CapCon Service.

Verify the CapCon system activity console (GUI)

1. Log in to the IIM console as an administrator. The CapCon Console loads automatically.
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The data in the CapCon System Activity console polls at the rate set by the del ayBet weenRXpol | s variable
inthe syst em pri vat e. confi g file. The default is set to 7 seconds. A message indicates the total number
of items in the index. The index number is the number of active alerts on the BlackBerry AtHoc system at that
time.

2. Verify that the IIM console does not show any new errors.
CapCon Console ID: BlackBerry AtHoc 293526 -0 IEN

_— o -‘-— =
o ol BBEO0ATOL 383 2eS

CapCon Syem [rrory Dxceptons Warnngs Conscle

Post Log Flles

3. Verify that the console icon in the task tray appears green, indicating that the connectivity between the IIM and
the BlackBerry AtHoc Alerts system is good.

- @ 3:20 PM
: 12/5/2017

Troubleshooting

If the CapCon System Activity console indicates anything other than a total number of items in the index and a
number, or if the CapCon System Errors/Exceptions/Warnings console has content in red, this indicates that the
configuration has not been executed correctly.

1. If the BlackBerry AtHoc management system, for example, https://integration4.athoc.com/client/default.asp
is available on IE on a local workstation, then the indexURL should also be available. Enter the indexURL in the
browser. For example, https://integration7.athoc.com/syndication/cap_ace3600/2050336/capindex.

If there are no items in the syndication feed, an XML similar to the following image should be displayed:
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<?xml version="1.0"?>
- <caplIndex xmins="http://www.incident.com/cap_index/1.0">
<title>Current CAP Messages</title>
<updated>2018-08-21T04:24:40.6406671-07:00</updated>
</capIndex>

If there are items in the feed, an XML similar to the following image should be displayed:

<?xml version="1.0"?>
- <caplIndex xmins="http://www.incident.com/cap_index/1.0">
<title>Current CAP Messages</title>
<updated>2018-08-29T01:26:47.2516109-07:00</updated>
- <item xmlins="http://www.incident.com/cap_index/1.0">
<id>293C2867-64E2-4B0OD-BBD5-FEC10C74CFOC</id>
<identifier>293C2867-64E2-4B0OD-BBD5-FEC10C74CF0OC</identifier>
<sender>AtHoc Admin</sender>
<status>System</status>
<msgType>Alert</msgType>
<firstEffective>2018-08-29T01:26:02.913 < /firstEffective>
<lastExpires>2018-08-29T01:41:02.913 </lastExpires>
<url>https:/ /integration7.athoc.com/Syndication/CAP_PA_2050363/Caplim/1147460</url>
<bounds/>
<format>http://www.incident.com/cap/1.1</format>
</item>
</capIndex>

If connectivity is still not good, try commenting out the pr oxySer ver and pr oxyPor t variables.

If an HTTP or HTTPS error is displayed instead of XML, this may indicate a firewall or certificate issue or a
configuration problem with the BlackBerry AtHoc server syndication folder or subfolders.

Check the indexURL and proxy settings in the syst em pri vat e. confi g file for any misspellings. If any line
have been misspelled, repeat the configuration steps.

Check the capnodel og file for errors. Open Windows Explorer by right-clicking on the IIM Start button and
navigate to C. / Progr am Fi | es/ capnode/ capnodel ogs and open the capnode. | og file with Notepad.
Browse the file to find the time that the indexURL was changed and the CapCon service restarted.

Contact BlackBerry AtHoc technical support. Be prepared to provide

the system pri vat e. confi g and capnode. | og files and screen shots of the console screen and the
BlackBerry AtHoc management console pages.
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Publish and verify a pre-test alert template

Create a template that targets end users using Desktop Popup, email, and messages to other devices to inform
them of a Giant Voice System test.

Prerequisites

+ Before you start sending test alerts through Public Address System, consider the impact on everyone within
hearing distance of the poles you are using during the test.
Consult with your POC about the acceptable content, user targeting, and device selection of the pre-test
notification.

Log in to the BlackBerry AtHoc management system as an administrator.

Click Alerts > Alert Templates.

Click New.

On the New Template screen, in the Alert Template section, enter a template name and description.

Select a folder from the Folder list. Select Test, if available.

Select Available for quick publish and Available for mobile publishing.

Select Informational from the Severity list.

Select Other from the Type list.

In the Content section, enter an alert title. The alert title can be the same as the template name.

0 In the Alert Body field, enter the text to be read by the text-to-speech. The Body should contain the details of
the testing with information such as the time testing will start and finish and any actions that should be taken
as a result.

11.In the Target Users section, select the appropriate targeting group, individual users, or query to send the pre-
test notification to.

12.Click Select Personal Devices and then select Desktop App and Email-Personal.

13.In the Personal Devices section, click Options.

14.In the Personal Device Options screen, select App Template and App Audio.

15.Click Apply.

16.In the Schedule section, change the Alert Duration to the expected duration of the testing.
17.Click Save.

18.click &.

19.0n the Home page, in the Quick Publish section, find the Giant Voice System Test Notification template.
20.Click Review and Publish.

21.Review the settings and selections.

22.Click Publish.

23.To verify that the alert was published correctly, observe the receipt of desktop pop-up or email messages on
the POC workstation.

—“°9°>‘9‘$":"“9°!"7‘
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BlackBerry AtHoc Customer Support Portal

BlackBerry AtHoc customers can obtain more information about BlackBerry AtHoc products or get answers to
questions about their BlackBerry AtHoc systems through the Customer Support Portal:

https://support.athoc.com/customer-support-portal.html

The BlackBerry AtHoc Customer Support Portal also provides support via computer-based training, operator
checklists, best practice resources, reference manuals, and user guides.
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Legal notice

©2019 BlackBerry Limited. Trademarks, including but not limited to BLACKBERRY, BBM, BES, EMBLEM Design,
ATHOC, CYLANCE and SECUSMART are the trademarks or registered trademarks of BlackBerry Limited, its
subsidiaries and/or affiliates, used under license, and the exclusive rights to such trademarks are expressly
reserved. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation
provided or made available on the BlackBerry website provided or made accessible "AS IS" and "AS AVAILABLE"
and without condition, endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and
its affiliated companies ("BlackBerry") and BlackBerry assumes no responsibility for any typographical, technical,
or other inaccuracies, errors, or omissions in this documentation. In order to protect BlackBerry proprietary and
confidential information and/or trade secrets, this documentation may describe some aspects of BlackBerry
technology in generalized terms. BlackBerry reserves the right to periodically change information that is contained
in this documentation; however, BlackBerry makes no commitment to provide any such changes, updates,
enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software,
products or services including components and content such as content protected by copyright and/or third-
party websites (collectively the "Third Party Products and Services"). BlackBerry does not control, and is not
responsible for, any Third Party Products and Services including, without limitation the content, accuracy,
copyright compliance, compatibility, performance, trustworthiness, legality, decency, links, or any other aspect
of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services in this
documentation does not imply endorsement by BlackBerry of the Third Party Products and Services or the third
party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL
CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES,
REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE,
MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR
ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE
DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE,
SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED.
YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY

NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT
PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO
THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO
NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE
SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL
BLACKBERRY BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE,

OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD

PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE
FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE,
OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY
EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS
OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA,
PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH BLACKBERRY PRODUCTS OR
SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY PORTION
THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR
SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES
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WERE FORESEEN OR UNFORESEEN, AND EVEN IF BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL
HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO
YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE
OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF
CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A
FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT
OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR
SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED
BLACKBERRY DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE
DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY
AFFILIATES OF BLACKBERRY HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to
ensure that your airtime service provider has agreed to support all of their features. Some airtime service
providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service.
Check with your service provider for availability, roaming arrangements, service plans and features. Installation
or use of Third Party Products and Services with BlackBerry's products and services may require one or more
patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You
are solely responsible for determining whether to use Third Party Products and Services and if any third party
licenses are required to do so. If required you are responsible for acquiring them. You should not install or use
Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and
Services that are provided with BlackBerry's products and services are provided as a convenience to you and are
provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties
of any kind by BlackBerry and BlackBerry assumes no liability whatsoever, in relation thereto. Your use of Third
Party Products and Services shall be governed by and subject to you agreeing to the terms of separate licenses
and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or
other agreement with BlackBerry.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with
BlackBerry applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS
WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY
PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

BlackBerry Enterprise Software incorporates certain third-party software. The license and copyright information
associated with this software is available at http://worldwide.blackberry.com/legal/thirdpartysoftware.jsp.

BlackBerry Limited

2200 University Avenue East
Waterloo, Ontario

Canada N2K 0A7

BlackBerry UK Limited
200 Bath Road

Slough, Berkshire SL1 3XE
United Kingdom

Published in Canada
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